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Abstract

New computer graphic developments at Oak Ridge National Ridge National Laboratory (ORNL) are
being used to provide visualization of criticality safety models and calculational results as well as tools for
criticality safety analysis input preparation. The purpose of this paper is to present the status of current
development efforts to continue to enhance the SCALE (Standardized Computer Analyses for Licensing
Evaluations) computer software system. Applications for criticality safety analysis in the areas of 3-D model
visualization, input preparation and execution via a graphical user interface (GUI), and two-dimensional (2-
D) plotting of results are discussed.

Introduction

The SCALE (Standardized Computer Analyses for Licensing Evaluations) computer software system
developed at Oak Ridge National Ridge National Laboratory (ORNL) is widely used and accepted around
the world for criticality safety analyses. SCALE includes the well-known KENO V.a and KENOVI three-
dimensional (3-D) Monte Carlo criticality computer codes. The purpose of this paper is to present the status
of current development efforts in the areas of 3-D model visualization, input preparation via a graphical user
interface (GUI) design, and two-dimensional (2-D) plotting of results, to continue to enhance SCALE for
criticality safety analysis.

KENO3D

Criticality safety analyses often require detailed modeling of complex geometries. Checking the accuracy
of these models can be enhanced by effective visualization tools. To address this need, ORNL has recently
developed a powerful state-of-the-art visualization tool called KENO3D. KENO3D enables KENO V.a and
KENO VI users to interactively display their 3-D geometry models. The interactive options include

      Shaded or wireframe images
      Standard views, such as top view, side view, front view, and isometric (3-D) view
      Rotating the model
      Zooming in on selected locations
      Selecting parts of the model to display
      Editing colors and displaying legends
      Displaying properties of any unit in the model
   



Creating cutaway views
      Removing units from the model
      Printing image or saving image to common graphics formats

KENO3D reads existing CSAS/KENO V.a or CSAS6/KENO VI input files. It attempts to verify that
the KENO geometry input conforms to the code input guidelines. KENO3D prints a warning message for
illegal geometry input, and if possible, it displays the illegal KENO V.a geometry to facilitate debugging of
the input. Problems with up to 120,000 KENO V.a bodies have been successfully tested and displayed.
Display of a sample light water reactor (LWR) fuel assembly shipping container model is shown in Figure 1.

KENO3D has several unique options that provide users with increased flexibility in visualizing portions
of the model in greater detail. One option is an interactive block eraser.  The user drags the eraser to the
desired location by holding down the left mouse button, and then clicks on the eraser button to remove the
part of the model under the eraser. Another option is referred to as “rebuild in window.” With this  option
the user can draw a window around a portion of the model in  the view. KENO3D will then reload the model,
displaying only the portion that is in the window.  This option is useful when  displaying smaller parts of a
complicated model.

Figure 1.  KENO3D sample LWR shipping container.

Toolbars

KENO3D has the look and feel of a typical PC Windows application. Toolbar buttons are included for
all major menu options.  A setup dialog allows the user to specify toolbars that should be displayed. The
default is to display all toolbars.  Toolbars can be "undocked" and placed anywhere on the desktop. Changes
to toolbar settings and background colors can be made permanent or temporary.



The toolbars and their functionality are described below.

Standard Toolbar

The standard toolbar contains five buttons:

Open file.  This button is the same as the “Open” option under the File menu.  The active folder will be
opened, and a file dialog box will allow the user to select the appropriate input file to display.

Reload Active File From Disk.  The file in the active window will be reloaded by rereading the input file.

Reload Active File From KENO3D Memory.  A list of KENO units in the active file is presented. The user
may select any unit from this list to display.  The file on disk is not re-read.

Print File.  A print file dialog is started.  The display of the active file may be printed.

Copy Screen to Clipboard.  Clicking this button causes the image in the active KENO3D window to be
copied to the clipboard.  The contents of the clipboard may be pasted into other applications (e.g., Word,
Paint, WordPerfect, etc.)

Views Toolbar

The Views Toolbar contains four buttons:

Isometric (3-D) View.  The active model is displayed in an isometric or 3-D view.

Top View.  The active model is displayed from the top.

Right View.  The active model is displayed from the right.

Front View .  The active model is displayed from the front.

Zoom Toolbar

The Zoom Toolbar contains three buttons:

Zoom All.  The active model is zoomed to fill the window.



Zoom Window.  The user draws a window around a portion of the model by dragging the mouse while
holding the left button down.  The window is complete when the user releases the left button.  Clicking the
left button again will cause that portion of the model that is contained in the window to be zoomed into full
view.

Zoom Using Mouse.  The active model can be zoomed in or out by holding down the left mouse button, and
dragging the mouse up or down.

Camera Toolbar

The Camera Toolbar contains three buttons:

Orbit Camera .  The “camera or view position” can be orbited around the active model by holding down the
left mouse button and dragging the mouse.

Pan Camera. The view position for the active model can be panned left or right by holding down the left
mouse button while dragging the mouse. 

Rotate View.  This menu button causes the Rotate View Around Axis Toolbar to pop up. 

Rotate View Around Axis

The Rotate View Around Axis Toolbar does not show up by default; however, the user may choose to
leave this toolbar active.  This toolbar becomes active by clicking the Rotate View button on the Camera
Toolbar.

Rotate View Around X-Axis.  The view position for the active model can be rotated around the x-axis by
holding down the left mouse button while dragging the mouse.

Rotate View Around Y-Axis.  The view position for the active model can be rotated around the y-axis by
holding down the left mouse button while dragging the mouse.

Rotate View Around Z-Axis.  The view position for the active model can be rotated around the z-axis by
holding down the left mouse button while dragging the mouse.



Display Options Toolbar

The Display Options Toolbar contains five buttons:

Shaded Image.  The active model is displayed as a shaded image.

Wireframe Image.  The active model is displayed as a wireframe.

Highlight Edges.  The active model is displayed as a shaded image with edges highlighted.  Clicking this
button will toggle edge highlighting on or off.

Light Intensity .  The user may change the intensity of the “lights” by clicking this button and using the light
intensity dialog box.

Refresh Wireframe.  Clicking this button will cause the wireframe to be reconstructed at the present zoom
level.  For example, a very small image of a cylinder might actually be displayed as a hexagon. After
zooming, refreshing will cause KENO3D to recalculate the vertices, possibly displaying a smoother
wireframe image.

Pick/Erase Toolbar

The Pick/Erase Toolbar contains three buttons:

Display Properties. The user may click on selected model parts using the left mouse button to display
information about the selected part (e.g., mixture, unit, etc.).

Erase Mixture.  Clicking this button will display a list of materials in the active model.  The user may select
a mixture to remove from the view.

Erase Body.  Clicking this button will activate the erase body mode.  In the erase body mode the user may
click on any part of the model, and KENO3D will erase that part after confirmation.

Legend and Axis Options Toolbar

The Axes/Legend Toolbar contains five buttons:

Display Color Legend.  Clicking this button causes a color legend to appear in a separate window for the
model in the active view.

Display-axes Centered. Clicking this button causes the x-, y-, and z-axes to be displayed centered in the
active model.



Display-axes Offset. Clicking this button causes the x-, y-, and z-axes to be displayed to the right of the
active model.

Remove Axes. Clicking this button causes the x-, y-, and z-axes to be removed from the display.

Move Axes. The user may click this button to move the axes to a new position.  Once the button
is clicked, dragging the mouse with the left button down will move the axes.

Cutaway Views Toolbar

The Cut Tools Toolbar contains four buttons.

Interactive Eraser.  The model is switched to wireframe.  A red, rectangular eraser is shown in the view.
The user may drag this eraser to any position.  Double clicking the mouse will remove the portion of the
model inside the red wireframe.  The user may change views during this operation. When satisfied with the
position of the eraser, double clicking the mouse will invoke the removal operation.  The operation may be
cancelled by reclicking the Interactive Eraser button.

Remove Section.  Cuts a rectangular solid section out of the model.  The user can select quarter, top, right,
front, left, right, back, or bottom. 

Pie Slice.  Makes a pie slice of the model.  User selects the cut angle and the axis parallel to the cut.

Reload In Window.  The user defines a plane, such as x-y plane.  For this reload the third plane is considered
infinite.  The user draws a rectangle around a region of the model by depressing the left mouse button and
dragging the mouse.  The rectangle is complete when the left mouse button is released. Clicking the left
mouse button again will cause KENO3D to reload the model from file and build only the portion that falls
within the window.  The user may cancel this operation by reclicking the “Reload In Window” button any
time prior to the final mouse click.

The Menus

Six pop-up menus are below the title bar of the main window,  with corresponding toolbar buttons for most
of the menu options.  Prior to loading a model only three menus are shown (e.g., File, Setup, and Help). 

File Menu

x Open
x Close
x Reload File
x Save As Picture
x Print, Print Setup
x Print Preview
x Recent Files
x Exit 

Most of these are self-explanatory.  Save As Picture allows saving the screen image in a Windows
Metafile Format for import to other applications, such as Paint, Word, WordPerfect, etc.



View Menu

x Standard Views
- Isometric (3-D)
- Top
- Right
- Front
- Bottom
- Back
- Left

x Display
- Add Legend
- Show Axes Centered
- Show Axes Offset
- Remove Axes
-     Move Axes

x Cutouts
- Remove Section
- Pie Slice
- Interactive Eraser
-     Rebuild In Window

x Camera
- Orbit
- Rotate
- Pan
- Zoom Window
- Zoom All
- Zoom Mouse
- Zoom In
- Zoom Out

x Select
- Unit From Memory
- Display Properties
- Erase Mixture
-     Pick Body To Erase

The View Menu also contains selections:

x Set Lights.  The user may change the intensity of the “lights” by selecting this option and using the
light-intensity dialog box.

x Shade.  The active model is displayed as a shaded image.

x Highlight Entities .  The active model is displayed as a shaded image with edges highlighted.
Selecting this option will toggle edge highlighting on or off.

x Wireframe . The active model is displayed as a wireframe.

x Refresh.  Selecting this button will cause the wireframe to be reconstructed at the present zoom level.
 For example, a very small image of a cylinder might actually be displayed as a hexagon. After
zooming, refreshing will cause KENO3D to recalculate the vertices, possibly displaying a smoother
wireframe image.

Window Menu

x New Window makes a copy of the active window, which can allow the user to have multiple views
of the active model.  For example, the view can be changed from isometric to top view in the active
window.  However, any changes to the active model, such as a cutaway or reload, will be reflected
in all windows showing the active model.

x Cascade presents all model windows in a hierarchical order.

x Tile tiles all model windows.



The Setup Menu

The Setup Menu allows the user to change background color, toolbar settings, optimization level,
interactive options, and CSAS options.  Changes can be made permanent, or temporary.  A “Reset Defaults”
button will reset all setup options to the original installation settings.

A production version of KENO3D for Windows 95, 98, and NT should be available in late 1999.

The Edit Menu

The Edit Menu contains a single option, Copy to Clipboard.  This option copies the active window to
the clipboard for importing to other applications, such as commercial word processing and graphics software
programs.  After selecting this option, and changing to another application, the paste command in the other
application can be used to copy the image of the active window into that application.

The Help Menu

The help menu provides online guidance in the use of KENO3D. Clicking on the option About
KENO3D displays the version number of the software.

CSPAN Graphical User Interface for CSAS/KENO V.a

To improve the ease of use, especially for new and occasional users, a graphical user interface (GUI) is
being developed to assist users in the input setup and execution of any SCALE criticality safety analysis
sequence (CSAS). The GUI, know as CSPAN (Criticality Safety Input Processor for Analysis) will run on
Windows 95, 98, and NT PCs. The program provides input menus and context sensitive help to guide the
user through the setup of their input. It will contain a direct link to KENO3D to allow the user to view the
components of their geometry model as it is constructed. Once the input is complete, the user can click a
button to run the CSAS case. A sample input menu screen from CSPAN is shown in Figure 2.

Two-Dimensional Plotting of Results

Criticality safety analysts often need to graphically display the results of their calculations. Another
recent SCALE development is a 2-D post-processing program to display calculated results from the SCALE
module XSDRNPM. XSDRNPLT is a Fortran utility executed by the SCALE driver on either a Unix
workstation or a PC. XSDRNPLT reads activity, balance table, and flux files produced by the 1-D discrete-
ordinates code XSDRNPM and writes ASCII files that can be plotted interactively on Windows PCs by a
Visual Basic program called XMART or on Unix workstations in batch mode using the freeware program
PGPLOT.  Parameters that can be plotted include fission sources, absorptions, leakages, fission rates, fluxes,
and reaction rates versus energy or distance. A sample XMART plot is shown in Figure 3.

Conclusion

The primary objective in the initial development and ongoing enhancements to SCALE is to provide an
easy-to-use calculational tool for performing accurate safety analyses of nuclear fuel facilities and package
designs using current computing techniques. The current development activities described in this paper are
part of the continuing effort to meet that objective.

The presentation of this paper will focus on live demonstrations of KENO3D, CSPAN, and XMART.



Figure 2.  Sample CSPAN geometry input screen.

Figure 3.  Sample XMART flux plot.
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